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Operating & Maintaining the Connex500/350 3-D Printer

Printer cover

Printing-materials &
storage compartment

Figure 7-1: The Connex500 3-D Printer

Starting the Connex Printer

& CAUTION!

® Do not attempt to operate the Connex printer before being trained by
an Objet customer-support representative.

® Observe all safety warnings and follow the safety guidelines described
in chapter 2.

1. Turn on the main power switch, located at the back of the Connex
printer.

Figure 7-2: Main power cable and switch

The main power switch turns on the Connex printer, which includes
the built-in Connex computer.
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2. After the computer boots, log in to Windows and launch the Connex
control application:

® On the computer desktop, double-click the Connex printer icon.

or—

® From the Start menu, select Objet > Connex500/350Connex500/350.
A valid HASP key is required on the printer computer for the application to
open. This key should be installed during printer installation. If the

application does not open and a HASP message appears, contact your
dealer or Objet Customer Support.

The Connex printer interface screen opens (see figure 7-3). All monitoring
and controlling of the Connex printer is done from this interface.

10 Jan 2008 16:46

Current activity

Previous job last slice: 91

FullCure?705 FullCure?05 VeroBlack VeroWhite

Model material
cartridges

i |
§ .
L —

Display
toggle button

Online/offline
button

Pause button

Figure 7-3: Connex500 interface

Connex installations utilize one monitor for displaying both the computer

running Objet Studio / Job Manager and the computer installed inside the
printer. Make sure that the KVM (keyboard-video-mouse) switch is in the

correct position so that the Connex printer interface is displayed.
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Loading Model and Support Cartridges

Connex printers use two cartridges of model material and two cartridges of
support material, each weighing 3.6 kilograms when full. A graphical
representation of the cartridges and their current weight appears in the
printer interface (see figure 7-3).

The printer uses RFID technology to automatically identify the material
cartridges. For this purpose, an RFID module is part of the printer hardware.
Tampering with this module will render the printer inoperable and may void
Objet warranties and service contracts.

Important: If you need to replace the model material currently
installed with another type, see “Changing the Model Material”
on page 7-10. Otherwise, make sure to replace the model
cartridge with one containing the same type of material.

To load model and support cartridges:

1. On the front of the Connex printer (see figure 7-1), pull open the doors
of the storage compartment.

2. If you are replacing a cartridge, grasp its handle and pull the cartridge
out, taking care not to twist or turn it.

3. Load model and support cartridges into their respective
compartments—the model cartridge on the right, and the support
cartridge on the left. (Note that the cartridges only fit into their correct
compartments.)

You should feel some resistance, as a needle pierces the cartridge.

4. Check the Connex printer interface to make sure that the new cartridge
is detected and that its weight is displayed (see figure 7-3).

5. Close the storage-compartment door.

Tips about replacing cartridges:

® You can replace material cartridges either before or during printing.

® You can replace partially used cartridges to avoid the need for replacing
them during printing.

® You can load partially used cartridges, as long as they contain more
than 100 grams of material.
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Producing Models

A
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The Connex500/350 printer produces models by printing tray files
prepared in the Objet Studio application and sent to the printer from there.
For information about preparing model files for printing, see ”“Using Objet
Studio” or Objet Studio Help.

Before beginning to produce models, it is recommended that you check the
current printing quality of the print heads by performing a pattern test (see
“Pattern Test” on page 21).

To prepare the Connex printer for producing models:

1. Make sure that the build tray in the Connex printer is empty and clean.
If not, remove old material with the scraper, and clean the tray
thoroughly with cleaning fluid.

CAUTION: Use protective gloves when cleaning the build tray, and be
careful of the sharp edges of the scraper blade.

2. Make sure that there is sufficient model and support material loaded
in the printer, as indicated in the Connex printer interface (see
figure 7-3). You may want to replace the cartridges of model and
support material currently loaded in the printer to avoid the need for
replacing them during printing.

For installing material cartridges and replacing empty ones, see
“Loading Model and Support Cartridges” on page 7-4.

For changing the type of model material currently loaded, see
“Changing the Model Material” on page 10.

3. At the bottom of the Connex printer interface, click the red button to
switch the printer to online mode.

The color of the button changes from red to green (see figure 7-4). If
there is a job in the Job Manager queue, it is sent to the printer.

On the Connex printer interface, the printer mode changes from Idle to Pre-
print, as the printer’s components prepare themselves for production:

® The print block is heated.
¢ The UV lamps are powered and they warm up.

When printing begins, Job Manager sends seven slices to the Connex
printer. This is the standard buffer between the Job Manager and the
printer. As each slice is printed, the Job Manager sends another slice to the
printer.

Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough model
and support material in the supply cartridges, printing proceeds
automatically until the job is finished.

During printing, the server computer must remain on and it must
communicate with the Connex printer. Do not log-off Windows until printing
is finished.
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The Connex500/350 printer uses one or two model-material cartridges and
one support-material cartridge to produce models. If additional cartridges
are installed and they are not needed for the current print job, the printer

interface indicates which are being used:

® Blue cartridge—used for the print job
® Gray cartridge—not used for the print job

You can monitor printer status indicators by switching the printer interface
display. To do this, click the display toggle button in the printer interface

screen.
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wiames . ) IES

Heads Liquid

Pre Heater

Figure 7-4: Connex printer indicators
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The background colors in the printer indicator fields tell you at a glance
whether or not the value or item is suitable or ready for printing.

® Green—suitable/ready for printing
For example, in figure 7-4:

O Ambient—The ambient temperature of the printing chamber is
within the acceptable range.

O Heads Liquid—The level of model and support material in the print-
block reservoir is OK.

O Heads Vacuum—The vacuum level in the system is within the
acceptable range.

® Red—not suitable for printing (or indicates a warning)
For example, in figure 7-4:

O Waste—The weight of the waste container is grams, more than
allowed when beginning a print job. (See “Replacing the Waste
Container” on page 7-62.)

® Blue—not ready
For example, in figure 7-4:
3 UV lamps—The UV not on.

O Heads (°C)—The heads have not reached the temperature required
for printing models (in printing mode).

The color of the material cartridges displayed in the printer interface
indicates which cartridges are active for the current (or next) print job.

® Blue—active cartridges

® Gray—reserve cartridges
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Printing The printer interface screen changes when you send a print job from Job
Indicators Manager to the printer, and the printer is on line (see figure 7-5):

The mode changes from Pre-print to Printing.

The specific activity being performed is shown in the “current activity”
field.

Current job-printing information is displayed.
The printing progress bar is displayed.
The Stop and Pause buttons are enabled.

When the weight of a cartridge drops below 100 grams, the display of the
material level in the printer interface is red.

Printer mode—

Job information <

OQ]ET 10 Jan 2008 17:35

Printing Pass 1 Current Activity

Print Time 00:20:01 Slice 163 of 1013 (16.1%)

[———=-Job information

Height 4.73mm of 28.37mm Previous job last slice: 163
FullCure?05 FullCure705 VYeroBlack YeroWhite

9 2 5‘1
L - et

Progress bar
3140 gr 3600 gr 2360 gr 2000 gr

CONNEXSOOD

Pause button

Figure 7-5: Connex printer interface during printing
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Resuming Production After Printing has Stopped

If the printing process is interrupted for any reason, Job Manager stops
sending slices to the Connex printer.

To continue printing the model:

1. Switch the printer to online mode by clicking the red button at the
bottom of the Connex printer interface (see figure 7-3 on page 3).

The button changes from red to green (see figure 7-4 on page 6).

2. Make sure that the computer network connecting the printer and Job
Manager server is active.

3. In the Job Manager interface, click the Resume icon .

4. In the Continue from Slice dialog box that appears, confirm the slice
number, after checking the Connex printer interface.

OBJET 10 Jan 2008 17:36

Printer mode

stanaoy 1 I

Print Time 00:20:51 ' Slice 168 of 1013 (16.6%)
Last slice

Height 4.87mm of 29.37mm Previous jok last slice: 168 printed

Figure 7-6: Connex printer interface after interrupted printing

Continue from Slice:

Figure 7-7: Continue from Slice confirmation dialog box in server
(Job Manager) interface

5. If, for any reason, the correct number does not appear in the dialog
box, enter the number and click OK.

You cannot continue printing the model if:

® The number of the last slice printed does not appear in the Connex
printer interface, even if the server computer displays the Continue from
Slice confirmation dialog box.

® There was a relatively long interruption in printing, even if the “last
slice” and “continue from slice” indicators are correct. The part of the
model already printed may deform or shrink, and there might be a
visible difference between it and the newly printed part. The effects of a
printing stoppage on a model depend on the model size and structure,
model material used, ambient temperature and the length of the

stoppage.
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If you cannot continue printing:

1. Cancel the print job in Job Manager.

2. Remove the partially printed model from the build tray.

3. Send the job to the Connex printer again.

You can stop and later resume printing from either the Connex printer
interface or the Job Manager interface, since both applications are updated

when you use these commands. However, after clicking the Pause button in
the printer interface, you can only resume printing from the printer interface.

Changing the Model Material

Before producing models using a different type of model material than is
currently installed, run the Material Replacement wizard to flush the print
block and feed tubes.

You should carefully plan printing models with different model materials to
avoid unnecessary waste of the material loaded in the printer. The amount
of material flushed depends on the flushing cycle chosen and if you are
replacing one or both cartridges.

To replace the model material:
1. Start the Material Replacement wizard from the Options menu.

Go ta Tray Upper Position FS
@E Goto Purge Position Fé 13 Jan 2008 12:26
Wipe 7

Execute Purge Sequence 4
Pattern Test

Head Alignment

Heads Cleaning

Head Replacement

Load Cell Calbration

Shutdown Mater nt
UM Lamp Reeplacement
UM Calbration Wizard
Wiper Cleaning

Maintenance Counters...
Collect Service Data

bus job last slice: 0

FullCure?05 FullCure?05 VeroWhite FullCure?20

SUPPORT-2 SUPPORT-1 MODDEL-2 MODEL-1

CONNEX500

Figure 7-8: Starting the Material Replacement wizard from the Options menu

In the opening screen, click Next.

If the printer cover is not closed, a screen appears instructing you to
close the cover. Confirm that it is closed and click Next.
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4.

In the Compartment Selection screen, select the cartridge(s) you want to
replace, and click Next.

Material Replacement Wizard

Compartment Selection

Model-1 Compartment
Model-2 Compartment

OBJET

Figure 7-9: Compartment Selection screen

From the drop-down menu, choose the model material you want to
install, and click Next.

Material Replacement Wizard

Material Selection
Model-2 Compartment Model-1 Compartment
i_y_er_o\:\u"hite | i WeroBlack vl
Opgjer
I XK Cancel ] ’*Erevious] [ Mext ]

Figure 7-10: Material Selection screen

Note: This selection automatically affects the default material settings in
Objet Studio.

6. The Material Replacement Wizard continues as follows:

® If, according to your selections in the previous wizard screens, you
are replacing both model material cartridges, and the printer will be
loaded with two cartridges containing the same model material, the
Connex printer flushes the entire system, and prepares for printing
in Single-Material mode (see below). Continue with step 8 on
page 7-13.

® If, according to your selections in the previous wizard screens, you
are replacing both model material cartridges, and the printer will be
loaded with two different model materials, the Connex printer
flushes the entire system, and prepares for printing in Digital-
Material mode (see below). Continue with step 8 on page 7-13.

® If, according to your selections in the previous wizard screens, you
are replacing only one of the model-material cartridges, and the
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printer will be loaded with cartridges containing two different
model materials, the Printer Mode Selection screen appears.

Material Replacement Wizard

Printer Mode Selection
Choose the printing mode for producing models.

() Single Material Printing Mode (H5,HG)
() Digital Material Printing Mode [D#)

I X Qancel‘ ’*Erevious“ Mext ]

Figure 7-11: Printer-mode selection
7. Choose whether you want to produce models in Single-Material mode
or in Digital-Material mode, and click Next.
® Single Material mode
All four print heads are used to print, using one model material.

O This mode is required to produce build trays with the High Quality
setting, and to produce trays with the High Speed setting using only
one model material.

® Digital Material mode
Each of the model materials loaded is used in two of the four print heads.

3 If only one of the model materials is required for printing, models
are produced using two print heads. This makes it unnecessary to
replace the other model material cartridge.

O If model-material substitution is allowed, the printer produces trays
with the High Speed setting using a mixture of both model materials
(see “Model Material Substitution” on page 5-37).

Continue with step 8 on page 13.
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8. In the Flushing Options screen (see figure 7-12), choose how thoroughly
you want to flush the system.

Material Replacement Wizard
Qﬂa Choose the flushing cycle required:

() Econamy (30 min]

Flushing Options
e (%) Efficiency (110 min]

v

OsJeT

() High-performance (110 rin)

(Kewa] | <irere (G ]

Figure 7-12: Flushing Options screen

® Economy. This cycle can be used when replacing a light-colored
model material with a darker material (such as TangoBlack™ or
VeroBlack™), or if the exact color of the printed models is
unimportant.

The wizard flushes the system with the minimum amount of
material needed to ensure that models have the mechanical
properties of the new material.

® Efficiency. This option is adequate, in almost all situations, for
printing models with uniform and accurate color. It is
recommended because it can potentially save 25 to 75 percent of the
material used to flush out the old material, compared to the High
Performance cycle. Note, however, that there may be times when the
shade (color) of the printed model is slightly affected by material
previously used.

The wizard identifies the feed tubes and print heads requiring
cleaning, based on your selections in the previous screens, and
flushes only these parts of the system.

® High Performance. Use this cycle when the printed models must
have the exact color of the new material.

The wizard thoroughly flushes all of the feed tubes and print heads
needed for printing, based on your selections in the previous
screens. This is done even if a selected material is already present in
the system, since it might contain small amounts of material
previously used.
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9. Click Next, and take note of the warning screen.
Material Replacement Wizard E|
Please Note!

Beyond this point. selecting 'Cancel’ will abort the ‘Wizard
and disable printing

Resuming printing will only be possible after full
completion of this \Wizard.

©BJET

? Help x LCancel ‘ (Elevious‘ Hext) I

Figure 7-13: Material Replacement warning screen

Once you start this procedure, you must complete it before you can produce
models with the Connex printer. To perform the procedure at another time,
click Cancel. If you continue (by clicking Next) and you do not complete the
procedure, you must start the Material Replacement wizard again before
producing models.

10. To continue, click Next.

11. When prompted, load the new cartridge(s). Confirm this in the wizard
screen and click Next.

waterial Replacement Wizard

Load cartridge

After loading carridge(s). confirm:

YeroBlack loaded in Madel-1 compartment.
Yerowhite loaded in Model-2 compartment.

= Help x LCancel ‘ <& Preyinli ‘ Hext 3 |

Figure 7-14: Prompt to load new model cartridges

After identifying the new cartridge(s), the Connex printer begins filling
the print heads with the new model material.

Material Replacement Wizard @

Material Replacement process in
progress

This process will take aprox 30 min

00:21

Osjer

? Help x LCancel ‘ é = I {ext ‘

Figure 7-15: Material replacement: filling heads with new material
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12. When the final wizard screen appears, make sure that the screen
displays the newly-loaded material(s). Click Done to close the wizard.

& CAUTION: Dispose of all material cartridges in accordance with all
applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling. If this is done, protect the person handling
the cartridges from direct exposure to uncured resins.

The printer-control interface is automatically updated, and should
display the new materials. The Objet Studio interface (on the printer-
server workstation) is also updated, and displays the new materials.

Keeping the Connex Printer in Idle Mode

Between printing jobs, the Connex500/350 printer can be kept on for up to
one week. If the printer will not be used for more than a week, use the
shutdown wizard to automatically perform the procedures that must be
done before turning off the printer (see “Shutting Down the Connex
Printer,” below).

When the Connex500/350 printer stops producing models, the printer
software automatically reduces the temperature of the print heads as

follows:
Time after printing | Mode Change in heating of print heads
first 15 minutes Standby 1 none
next 10 hours Standby 2 heating reduced (to room temp.)
after 10 hours Idle heating stopped

Note: The printer mode is indicated in the green field on the left of the
interface (see figures 7-3, 7-4 and 7-5 on pages 3, 6 and 8).

If, after printing a job, you know that the printer will not be used for 10
hours or more, you can immediately turn off the heating of the print heads
by putting the printer into Idle mode.

To put the printer into Idle mode:

» From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the Connex printer
application and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this
mode—with the cover closed—for up to a week. For longer periods, shut
down the printer by running the Shutdown wizard (see below).
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Shutting Down the Connex Printer

You only need to shut down the Connex printer if it will not be used for a
week or more. Otherwise, the printer can remain on, in Idle mode. To
properly shut down, the printer needs to perform several processes. These
are controlled by the Shutdown wizard. Do not attempt to shut down the
printer by simply closing the computer interface (the printer-control
application), and never disconnect power to the printer before
completing this wizard.

Depending on the length of time the printer will not be used, you can
choose between a short shutdown procedure, and a more thorough
procedure.

¢ Up to 10 days: The wizard empties the print block of model and
support material, to prevent leaks. This takes about 10 minutes.

® More than 10 days: The wizard empties the print block, then flushes
the system with cleaning fluid. This takes up to 35 minutes, and you
must be present to load cleaning-fluid cartridges when instructed.

To run the Connex Shutdown Wizard:

1. Select Shutdown from the Options menu, or press F8.

Shutdown Wizard

= N Shutdown Wizard

This wizard controls the processes necessary for shutting
down the printer.
Fress 'Next' to continue or 'Cancel' to quit.

? (X Corcel ] | <t

Figure 7-16: Shutdown wizard, opening dialog box

In the opening wizard screen, click Next.

Choose the appropriate option for the length of time that the printer
will not be used —less or more than ten days.

Note: Before selecting More than 10 days, make sure that cleaning-fluid
cartridges are available.

4. In the next screen, verify that the tray is empty and click Next.
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The shutdown procedure begins.

Shutdown Wizard

L Shutdown in Progress
This step takes up to 10 minutes.
ShutDown
hi 00: 02
(0L

Figure 7-17: Shutdown progress screen

5. When the final wizard screen appears, close the printer-control
application and shut down the built-in computer.

Shutdown Wizard

N Shutdown Procedure Completed
You may now shut down the printer computer and turn off
power to the printer,

Oegjer

Figure 7-18: Final Shutdown Wizard screen

6. After the printer computer shuts down, turn off the main power switch
(at the back of the printer) (see figure 7-2 on page 2).
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Maintaining the Connex Printer

The performance of routine maintenance tasks is essential for getting
satisfactory results from Connex 3-D printers. Perform the tasks at
specified intervals for optimum performance.

Routine
Maintenance
Schedule

7-18

Frequency Task For More Information
Daily, before printing Clean the print heads. See “Cleaning the Print
Heads” on page 7-19.
Weekly Clean the build tray and
the surrounding area.
Weekly Perform the Pattern test. | See “Pattern Test” on
page 7-21.
Weekly Clean and inspect the See “Cleaning and
wiper. Replacing the Wiper”
on page 7-23.
Weekly Restart the Connex
printer computer and
the server computer.
Weekly Clean the roller waste | See “Cleaning the Roller
collector. Waste Collector and
Inspecting the Roller
Scraper (Knife)” on
page 7-25.
Every 200 hours of Test the UV lamps. See “Testing and
printing (A reminder Calibrating the UV
message appears.) Lamps” on page 49.
Monthly, and after Check the alignment of | See “Aligning the Print
replacing print heads the print heads. Heads” on page 7-30.
Monthly Calibrate the load cells. | See “Calibrating the
Load Cells” on
page 7-51.
Monthly Inspect the exhaust
system (duct, fan,
connections).
Every 2000 hours of Preventive maintenance | Contact your Objet

printing, or once a year

visit by authorized
service engineer.

support center.
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Cleaning the Periodic inspection and cleaning of the orifice plates on the bottom of the
Print Heads print block ensures that the print nozzles are not clogged. A wizard guides
you through the procedure, and adjusts components of the Connex printer
to enable you to perform it. This procedure takes about 20 minutes, and
should be done at the beginning of the work day or before a big printing
job.
To clean the print heads:
1. Prepare—

® isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)

disposable cleaning gloves
® an Objet-supplied cleaning cloth or equivalent
® amirror

2. Start the Heads Cleaning wizard from the Options menu of the printer
interface (see figure 7-26 on page 23).

3. Follow the instructions on the wizard screens, and select the check
boxes to confirm that:

® you have checked that the tray is empty.

® you have closed the cover.

Clean Heads Wizard EJ

Clean Heads Wizard

Flease check if the tray is empty and close the
doar.

W Tray iz empty
-

OBJET

XK Cancel | =£ Previnu ‘ Mext 3 ‘

Figure 7-19: Head cleaning procedure—wizard screen
4. Click Next.

The printer prepares for you to clean the print heads.
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5. When the following screen appears, open the cover.

Clean Heads Wizard EJ
o Are heads clean ?
Caution:
Heads | = Please open the door and clean heads.

are Hot!
I~ Heads clean

OBJET

Figure 7-20: Head cleaning wizard—steps 5-10

& WARNING: The print head orifice plates (bottom surface) may be hot.
Do not touch them with your bare hands, and proceed with caution.

Place the mirror on the build tray.
Put on the gloves.
Soak the cleaning cloth with the cleaning fluid.

v *® N

Clean the orifice plates, with a back-and-forth motion (see figure 7-21).
Use the mirror to make sure that you have removed all of the residue
material.

Figure 7-21: Cleaning the heads

It is recommended that you use this opportunity to also clean the roller and
the UV-lamp lens (to the right of the print heads).

10. When you have finished cleaning, select the confirmation check box in
the wizard screen (see figure 7-20) and click Next.
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Pattern Test

DOC-13000 Rev. E

11. Remove the cleaning materials from the printer and close the cover.

12. Select the confirmation check boxes in the wizard screen and click

Next.

The head-purge cycle begins. When this is complete, the final wizard
screen appears.

Clean Heads Wizard ['E

Heads clean wizard completed

OBJET

| {--.‘JDonel

Figure 7-22: Head cleaning wizard—final screen

13. Click Done to close the wizard.

The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the
print heads. Make sure, therefore, that you perform this test weekly, and
whenever you suspect a printing problem.

To perform the pattern test:

1.
2.
3.

Make sure that the build tray is empty.
Prepare a sheet of pink paper— A-4 or Letter size.

In the Connex printer, tape the pink paper to the surface left of the
build tray.

Press F3, or open the Options menu and select Pattern Test.

< Perform Pattern Test?

Figure 7-23: Pattern Test confirmation

If the build tray is not clear, click No in the following dialog box.

This lowers the build tray, so that models on the tray are not damaged.

< Is the build tray dear?
-..._*/ {If you dick 'NO', the tray will be lowered.)

Figure 7-24: Build tray (Z) level adjustment

The Connex printer prints a series of lines on the test paper.
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Figure 7-25: Sample Pattern Test

Carefully inspect the test paper to see if there are missing lines.

Too many missing lines, especially if they are in the same area,
indicates that the quality of printing when producing models will be
poor. If this is the case, see “Improving Print Quality,” below.

Note: Acceptable model quality is subjective, and depends on the type
and scale (size) of the models produced. As a rule, however, more than 10
missing lines in one area of a column is considered unacceptable.

If you suspect that print quality is poor, perform the pattern test (see
“Pattern Test” on page 7-21). If the results are poor, use the following
procedure to improve print quality.

If the results of the last pattern test are poor:

1.
2.

3.
4.

From the Options menu, select Execute Purge Sequence, or press F4.
In the confirmation dialog box, click Yes.

The print heads are purged of model and support material, and the
wiper removes excess material from them.

Repeat the purge sequence.

Perform the pattern test.

If the results of the pattern test are still poor:

1.

2.
3.

Manually clean the print heads (see “Cleaning the Print Heads” on
page 7-19).

Perform the purge sequence.

Perform the pattern test.

If the results of the pattern test are still poor:

1.

2.
3.

Carefully clean the print heads again, making sure there is no residue
left on them.

Perform the purge sequence.

Perform the pattern test.

If the results of the pattern test are still poor:

> Replace faulty print heads (see “Replacing Print Heads” on page 7-40).
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A rubber wiper removes excess material from the print heads after the
purge sequence. This is done automatically before each print job, and
performed manually during maintenance tasks. You should clean the
wiper and surrounding area at least once a week. If the wiper is damaged
or worn, replace it.

To inspect and clean the wiper:

1. Prepare—

isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
disposable cleaning gloves
an Objet-supplied cleaning cloth or equivalent

a spare wiper

2. Start the Wiper Cleaning wizard from the Options menu of the printer
interface.

File” Options Help
Go ko Tray Lipper Pastion F5
{  Goto Purge Posit
OE orabLrgeiroskin 13 Jan 2008  13:48
| Wipe
Execute Purge Sequence
Pattern

Head Alignment
Heads Cleaning

Maintenance Counters. ..
Head Replacement

| Colecse kst Load Cell Calbration

Shutdovn Material Replacement
U Lamp Replacement
LW Calibration Wizard
wiper Clearing

bus job last slice: 0

FullCure?05 FullCure705 VeroWhite FullCure720

SUPPORT-2 SUPPORT-1 MODEL-2 MODEL-1

CONNEXS00O

Figure 7-26: Starting the Wiper Cleaning wizard

3. Close the printer cover, and click Next in the wizard screen.

4. Make sure that the build tray is empty, and close the printer cover.
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10.

11.

Confirm this in the wizard screen.
Clean Wiper, Wizard g|

Clean Wiper Wizard

Check if the tray is empty and close the doar.

W Trayis empty

OBJET

xgancell ‘ Mext 3

Figure 7-27: Wiper Cleaning procedure—step 4
Click Next.

When the following screen appears, open the cover.
Clean Wiper, Wizard @

Is wiper clean?

Flease open the door and clean the wiper.

I~ The wiper iz clean

OBJET

X Corcl | <tpevioue | pend> |

Figure 7-28: Wiper Cleaning wizard during steps 7-10

Put on the cleaning gloves.

Using a generous amount of cleaning fluid and the cleaning cloth,
remove any material remaining on the wiper and the surrounding
area.

Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.

a. Grasp it and pull it up and out of its bracket.

b. Insert the new wiper blade, making sure that it is straight and secured
well on both sides.

In the wizard screen (see figure 7-28), confirm that the wiper blade is
clean, and click Next.

Make sure that you have removed all tools and cleaning materials
from the printer, and close the cover.
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Inspecting the
Roller Scraper
(Knife)
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12. Select the confirmation check boxes in the wizard screen and click
Next.

Clean Wiper Wizard @

Clean Wiper Wizard

Check if the tray is empty and close the doar.

W Tray iz empty

OBJET

XK Cancel | <2 Preyiou ‘ Mext 3 ‘

Figure 7-29: Wiper Cleaning procedure—final confirmation screen

13. Click Done to close the wizard.

The roller waste collector removes waste material scraped from the roller.
Suction removes this waste to the printer’s waste container.

This assembly should be cleaned weekly to prevent a blockage in the tubes
leading to the waste container, so that waste material does not overflow
into the printer.

To clean the roller waste collector:

1. Prepare—

M2.5 and M2 Allen keys

disposable cleaning gloves

isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
cleaning cloth

cotton swabs (Q—tips® or similar)

2. Put on the gloves.
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3. Remove the right UV-lamp assembly:

a. Disconnect the UV power cable and the fan power cable.

Fan power
connector

Power connector

Figure 7-30: Disconnecting the right UV assembly

b. Remove the screw attaching the right UV lamp to the print block,
and then pull and lift up the UV lamp.

4. Loosen the two screws securing the suction tube on the print block

L%

uction tube screws

Figure 7-31: Lifting the suction tube

5. Lift the suction tube to secure it in a raised position.

6. Remove the two screws securing the covering of the roller waste
collector and remove it.

Be very careful to save the covering screws. These are special screws, if
they are lost you need to order replacements.
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Roller waste
collector screws

Figure 7-32: Removing the roller waste collector covering

Remove the covering by pulling it out, and then lower it.

Clean the roller waste collector and the scraper blade surface using
cotton swabs. Make sure to remove any remaining printing materials.

Figure 7-33: Cleaning the roller waste collector

Before replacing the covering you can check the effectiveness of the roller
scraper (knife) —see below.

To check the effectiveness of the roller scraper:

Ll

o

Put on the cleaning gloves.
Wet a cloth with isopropanol.
Use the cloth to wet the bottom of the roller.

Turn the roller slowly with your hand. As the blade scrapes the roller,
make sure the isopropanol is spread evenly over the entire length of
the blade

Inspect the roller. If it is not dry, replace the blade.

Before returning the roller waste collector to the print block, make sure
that the pins it rests upon are clean.

Roller waste
collector pins

Figure 7-34: Roller waste collector pins
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7. Return the roller waste collector to the print block and screw on the
covering (see figure 7-32 on page 7-27).

8. Loosen the screws securing the suction tube.

Figure 7-35: Suction tube correctly positioned

9. Lower it so that the hole in the panel behind the suction tube is visible,
and tighten the screws to secure the suction tube.

10. Attach the right-UV-lamp assembly to the print block and reconnect
the UV power and fan cables.
Replacing the  You should replace the roller scraper blade:
Roller Scraper e after 1,000 hours of printin
(Knife) ’ prng.

e if it does not effectively keep the roller clean.

You should periodically test the effectiveness of the roller scraper when you
clean the roller waste collector. See “Cleaning the Roller Waste Collector
and Inspecting the Roller Scraper (Knife)” on page 25.

To replace the roller scraper:

1. Prepare—
® anew roller scraper (knife) (Kit-01026-S)
® a Phillips 1x75 mm screwdriver
® M2.5 and M2 Allen keys

2. Remove the right UV lamp and the roller waste collector covering (see
steps 3 to 6 on page 7-26.)

3. Loosen the two screws securing the roller waste collector and pull it
out.

Figure 7-36: Removing the roller waste collector
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4. Remove the screws that secure the roller scraper assembly.

Figure 7-37: Removing the roller scraper screws

Figure 7-38: Removing the old roller scraper blade

5. Remove the scraper blade and discard it.

6. Place the new scraper blade onto the pins in the holder, as shown.

Figure 7-39: Inserting the new roller scraper blade
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7.

Insert and tighten the roller scraper blade screws.

Important:

® Tighten the screws in the order shown in Figure 7-40.

® Use the new screws supplied in the replacement-kit.

Figure 7-40: Tightening the roller scraper screws

After tightening the screws, inspect the blade and make sure that it is
straight. If necessary, loosen the screws and tighten them again, evenly.

Return the roller waste collector assembly and the right UV lamp to
the print block. See steps 6 to 10 from page 7-27.

You should check the alignment of the print heads—

® once a month

® after replacing one or more heads

® if model quality is not acceptable even after cleaning the orifice plate on

the bottom of the print block (see “Cleaning the Print Heads” on
page 7-19)

The head-alignment procedure takes about 20 minutes.

To check the alignment of the print heads:

1.

Prepare—
® atransparency sheet—A-4 or Letter size

® any type of sticky tape, to fasten the transparency sheet to the build
tray

Start the Head Alignment wizard, from the Connex Options menu (see
figure 7-26 on page 23).

Click Next to begin, and close the cover.

In the wizard screen, select the check box to confirm that the cover is
closed, and click Next.
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5. When instructed to do so, place the transparency on the build tray —
next to the left and rear edges of the tray, as shown in the following
figure.

Figure 7-41: Positioning the transparency on the build tray

Make sure that the transparency sheet is lying flat, and tape it to the
tray.

In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.

The Connex printer prints the head alignment test on the transparency.

When the following screen appears, remove the transparency.

@ |

Head Alignment Wizard [z|

Remove transparency from tray

I~ Transparency removed

P Help |

Figure 7-42: Head Alignment wizard—steps 8-10
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10.

The transparency sheet is printed with sets of vertical lines in seven
columns, each showing the results from a different print head.

Figure 7-43: Sample head-alignment test

® The three columns on the right were printed by the heads used for
applying model material when producing models. From right to
left, the columns represent heads M1, M2, M3, respectively. (There
is no column for head MO because its alignment is used as a
reference for aligning all other heads.)

® The four columns of lines on the left were printed by the heads used
for applying support material. The columns represent heads S3, 52,
S1 and SO, respectively.

For each column of lines, use a magnifying glass or loupe to inspect
pairs of consecutive rows printed on the transparency to see where the
vertical lines align.

Alignment-line
12345 67— numbering, left-to-right

Row pair

SRARAN

Figure 7-44: Comparing rows of alignment lines

Note: It does not matter which pair of lines you inspect, since they were all
printed by the same head. Choose a pair of clearly printed lines for the
inspection. (Since some nozzles may not print clearly, you may have to
inspect several pairs of lines to properly view the alignment.)

Optimum head alignment is shown when the fourth lines in the upper
and lower rows are aligned, as in figure 7-44. In the example shown, no
change to the head alignment is necessary. If other lines in the set are
aligned, you need to change the alignment of that head —in the next
wizard screens.

In the wizard screen shown in figure 7-42, select the Transparency
removed check box, and click Next.
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11.

12.

13.

The first in a series of alignment screens appears.

Head Alignment Wizard @

Head M1

Choose the best printed line in the transparency

OBJET

? Hep

Figure 7-45: Head alignment screen

XK Cancel | <€ Previous ‘

In the head-alignment screen, select the number that indicates which
lines align in the upper and lower rows of a pair on the transparency
(counting from the left) for this print head.

Note: Because the alignment of the fourth lines is optimum, the number “4”
is selected, by default, in the wizard screen. This does not change the head
alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.

Click Next to display the next head alignment screen, and again select
the number representing the most closely aligned vertical lines on the
transparency for that print head.

When you have finished aligning all of the heads, the following screen
is displayed.

@ |

Head Alignment Wizard @

Updating System Parameters

FL&L\ Do you want to update the system parameters?
W o+ “Yes

™ Mo

XK Cancel | (Erevious‘ PN

Figure 7-46: Updating System Parameters confirmation screen

Continue as follows:

¢ To make the alignment changes in the printer, make sure that Yes is
selected, and click Next.

® To recheck the alignment test results before making the alignment
changes in the printer, click Previous.

¢ If you do not want to make alignment changes in the printer at this
time, select No and click Next.
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14. In the final wizard screen, choose to either repeat the head alignment
procedure or close the wizard.

® If the most closely aligned vertical lines for a print head were at
either extreme —the first or seventh lines—choose Yes to run the
head-alignment wizard again, then click Next.

The transparency test will show if the heads are now properly
aligned, and —if not—the wizard will allow you to “fine tune” the
alignment.

® If the vertical lines for the print heads were not aligned at either
extreme, choose No to close the wizard, then click Next.

@ B

Head Alignment Wizard @

Do you want to repeat the test?
L

" “es - Print another transparency

* Mo - | want to end of Wizard

? Help XK Cancel | <€ Previous | PN

Figure 7-47: Final wizard screen

The condition of the print heads directly affects the quality of printed
models. To maintain optimum printing, you should routinely test the print
heads, and calibrate them to the best working configuration possible. You
do this by running the Head Optimization wizard.

During the optimization process, 32 samples are printed on the build tray.
After carefully weighing each of them, you enter the weight in the wizard's
data-entry screen. The wizard uses this data to optimize the heads.

If, during the optimization process, the wizard determines that a print head
is faulty —or that it is negatively affecting layer uniformity with the current
head configuration —the wizard instructs you to replace it. If this happens,
you can continue the wizard (to replace the print head) or abort the wizard
(to replace the head at another time).

Run the Head Optimization Wizard whenever the condition of print heads is
negatively affecting the quality of printed models, or if you suspect that there
is a problem with one or more of the print heads.

To test and calibrate the print heads:
1. Prepare—
® isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
e disposable cleaning gloves
® an Objet-supplied cleaning cloth or equivalent
® amirror

® the scale supplied by Objet for use in the Weight Test
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2. Start the Head Optimization wizard from the Options menu of the
printer interface.

Go ko Tray Upper Position FS

Go ko Purge Position 3 05 Jan 2010 16:48
Wiipe: F7 :

Execute Purge Sequence  F4

Pattern Test F3

Built In Tests... Ctrl+al+8 Wiper Cleaning

Head Cleaning

I R (T ¥ Calbration of 30 (40.0%)
Collect Service Data F2 N

LY Lamp Replacement

T Height 0.38mm of 0.96mm S e s job last slice: 12

B 1
Load Cell Calibration
Shutdown

FullCure705  FullCure705 VeroBlack VeroBlack

& 1l

| o
2100 gr

(T

Figure 7-48: Starting the Head Optimization wizard

3. Inthe opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.
Read the conditions, select I Agree and click Next.
5. Close the printer cover, and confirm this in the wizard screen.

In the following screen, make sure Optimize all print heads is selected,
and click Next.

Head Optimization Wizard

Select the procedure required

(%) Dptimize all print heads.

() Replace faulty heads and optimize all heads.

OBJET

[ x Qancel] ’(Erevious][ ﬂext)’ ]

Figure 7-49: Procedure selection screen

The print block moves into position for cleaning and inspecting the
print heads.
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7. When the following screen appears, clean the print heads.

WARNING: The print head orifice plates (bottom surface) may be hot.
Do not touch them with your bare hands, and proceed with caution.

Head Optimization Wizard

Clean the print heads
Confirm before continuing:

[ The print heads are clean.

OBJET

Figure 7-50: Clean print heads screen

Place the mirror on the build tray.
9. Put on the cleaning gloves.
10. Soak the cleaning cloth with the cleaning fluid (alcohol).
11. Clean the orifice plates, with a back-and-forth motion.

Figure 7-51: Cleaning the print heads

Use the mirror to make sure that you have removed all of the residue
material.

12. When the print heads are clean, select the confirmation check box in
the wizard screen and click Next.

13. Remove the cleaning materials from the printer, and close the cover.

14. Select the confirmation check box in the wizard screen and click Next.
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The head-purge cycle runs, after which the Weight Test is printed.

Head Optimization Wizard

Printing Weight Test

nﬁ This step takes about 55 minutes.

00:19
OBJET

Figure 7-52: Printing Weight Test

15. 32 samples are printed on the build tray, four for each of the print

heads. This can take up to 55 minutes.

16. When the following screen appears, open the printer cover. Enter the
data that describes the condition of each print head, after inspecting

each of the printed samples.

Head Optimization Wizard

Weight Test Data Entry
Enter: Build tray map
Missng S3 52 81 S0 M3 M2 M1
Mozzles
‘weight
(@3]
’ Edit data ] I: x Qancelﬂ

L1}

Figure 7-53: Weight Test Data Entry screen

The layout of the data entry screen matches the printed samples on the

build tray. Enter the data for the sample indicated by & in the screen.

a. Enter the number of faulty (“missing”) nozzles.

Faulty nozzles are seen in Weight Test samples as a missing row of
printed material. Compare the height of the missing row with the

lines printed on the “missing nozzles” ruler. Enter the number next
to the line that most closely matches the height of the missing row.

7-37



Operating & Maintaining the Connex500/350 3-D Printer

7-38

17.

d.

Ruler

Missing line

Printed sample

Figure 7-54: Measuring the missing line in a printed sample

In the example above, you would enter “1” in the wizard screen.

. Carefully remove the sample, weigh it, and enter the weight in the

wizard screen.

Be sure to remove and weigh the entire sample, even if it breaks into
several pieces.

Click Apply or press Enter.
The data-entry-indicator €@ moves to the next position.

Repeat these steps for all 32 samples.

To change an entry, click Edit Data, enter the correct data, and click Save.

When you have entered the all of the data in the wizard screen,
click Next.

The wizard uses the data you entered to analyze the condition of the
print heads, and optimizes them so they print models with a uniform
layer of material. If the heads are in satisfactory condition, the final
wizard screen appears.

Head Optimization Wizard

Print-head Optimization

) Completed

&

OBJET

Figure 7-55: Final wizard screen, after optimizing print heads
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18.

However, if the wizard determines that a print head is faulty —or that it
is negatively affecting model quality with the current head
configuration —the wizard instructs you to replace it. In this case, the
following screen appears.

Head Optimization Wizard
Weight Test Results
M3, M2 defective.

() Replace defective head(s).

O Abort wizard.

OBJET

Figure 7-56: Defective print heads found

Choose Replace defective head(s) if you are prepared to replace the print
heads now.

or—

Choose Abort wizard if you want to replace the print heads at another
time.

Replacing print heads is expensive. Replace them only after consulting with
an Objet-authorized customer-support engineer.

If you are replacing the print heads now, the wizard guides you through the
procedure when you click Next. Continue with “Preparing the print block”
on page 41.
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The condition of the print heads directly affects the quality of printed
models. You need to replace a print head if one or more of the following
symptoms occurs:

® The Head Optimization wizard determines that one or more print
heads are defective. (See “Calibrating Print Heads” on page 34.)

® There are noticeable grooves in the surface of printed models.

® Visual inspection of the head reveals that its surface is damaged —
peeling or bubbles in the nozzle area.

® The Connex interface displays a warning or malfunction message
relating to a print head —

O Head Heater temperature timeout
O Head Heater thermistor open
O Head Heater thermistor short

Replacing print heads is expensive. Replace them only after consulting with
an Objet-authorized customer-support engineer.

The Head Optimization wizard guides you through the procedure of
replacing a print head, and adjusts components of the Connex printer to
enable you to perform it. Only replace a print head with the aid of the
wizard. The procedure takes 75—90 minutes, and consists of the following
phases:

A. Identifying the head(s) needing replacement.

This is normally done by the Head Optimization wizard. Otherwise,
evidence of physical damage to the head surface or a malfunction
message indicates which head needs replacing.

=

Preparing the print block for head replacement.

This is done automatically when you run the wizard.
Removing the defective print head.

Installing a new print head.

Optimizing the print heads (done automatically by the wizard).

Mmoo

Performing head alignment.

To replace a print head:
1. Prepare—
® replacement print head(s)
® isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
® disposable safety gloves (included in the head replacement kit)
® an Objet-supplied cleaning cloth or equivalent
® a flat-head screwdriver (5 mm)
® the scale supplied by Objet for use in the Weight Test
Note: Make sure that you have these items before running the wizard.

2. Start the Head Optimization wizard from the Options menu of the
printer interface (see figure 7-48 on page 35).

3. In the opening wizard screen, click Next to begin.
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The Wizard Conditions screen appears.

4. Read the conditions, select I Agree and click Next.

Head Optimization Wizard

Select the procedure required

() Dptimize all print heads.

(5) Replace faulty heads and optimize all heads.

OBJET

[ X Qancel] ’*Erevious” Mext - ]

Figure 7-57: Procedure selection screen
5. Choose Replace faulty heads, and click Next.

Preparing the 6. Select the print head(s) needing replacement, and click Next.
print block . n

Head Optimization Wizard

Select heads to be replaced

OBJET

I XK Cancel ] ’*Erevious]

Figure 7-58: Head selection screen

The Connex printer heats and empties the print block, and prepares the
printer. (This should take up to 30 minutes.)

Head Optimization Wizard

m Preparing for Head Replacement
i A - ll This step can take up ta 30 min.
00:05
Opgjer

Figure 7-59: Printer preparation progress screen

7. Put on the safety gloves.
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8. When the following screen is displayed, open the Connex printer
cover.

Note: The Connex printer disconnects power to the heads for your safety.

Head Optimization Wizard
Print Head Replacement

The printer is ready for you to replace print heads.
Click 'Next' to continue.

OBJET

Figure 7-60: Replace the defective head when this screen appears

Removing the 9. On the print block, release the upper and lower screws that secure the
Defective Head print head in the block. (If necessary, you may use a screwdriver to
loosen the screws.)

Figure 7-61: Releasing the locking screws

10. Press down on the upper and lower locking screws to release the print
head.

Figure 7-62: Releasing the print head
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11. Loosen the screws on the door of the compartment protecting the
print-head driver cards (A), then pull and lift up the door (B).

Figure 7-63: Opening the print-head compartment

12. Pull the print-head driver card out of its socket so that the head is free
(A), and remove it from the bottom of the print block (B).

Figure 7-64: Releasing the print-head driver card to remove the head

13. Make sure that along with the head, you remove the two rubber O-ring
seals.

Figure 7-65: O-ring seals on the print head

Important: If the seals are not removed with the head, they are probably
stuck to the print block housing. If so, remove them.
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Figure 7-66: Making sure the O-rings are not stuck to the print block

Installing the Important: Remove the protective tape from the surface of the
New Head new print head.
14. Inspect the replacement head, and make sure that the O-ring seals are
in place (see figure 7-65).
15. Gently insert the replacement head into the vacant slot in the print
block, and push the print-head driver card into its socket.

Note: Make sure to insert the head with the driver card facing its socket, in
the rear of the print block.

Figure 7-67: Inserting the print-head driver card into its socket
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16. Push the head up until you hear it click into place, in both front and
rear holders.

Figure 7-68: Clicking the head into place in the print block

17. Lower the door of the print head compartment, and tighten the screws
to lock it in place.

18. Tighten the upper and lower screws that secure the print head in the
print block (see figure 7-61 on page 42).

Note: Hand-tighten these screws. Do not use a screwdriver.

19. With your fingers, make sure that the new head is level and even with
the other heads.

Figure 7-69: Checking the level of the new head

20. Confirm that the heads are level and even by selecting the check box in
the following wizard screen, and click Next.
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Head Optimization Wizard

Installation Check
Check thatthe print heads are level and even.
- [ Done
nnnﬁnnnn
Opgjer
I XK Cancel ] ’*Erevious]

Figure 7-70: Installation-check screen

21. In the next wizard screen, select the check box to confirm that you have
removed all tools and objects from the printer.

Head Optimization Wizard

Inspect the build tray

Confirm before continuing:

[ The build tray is clear (smpty).

OBJET

Figure 7-71: Cleared-tray confirmation screen

22. Close the printer cover.

The wizard continues by filling the heads, then heating and purging them.
If there are no installation problems, the Head Optimization procedure
begins (see “Calibrating Print Heads” on page 7-34).

If a vacuum leakage is detected, or if there are other problems, the wizard
alerts you and instructs you how to continue (see “Installation Problems,”
below).

After replacing print heads, you should check the head alignment before
using the Connex printer to produce models. In the final wizard screen...

® select Yes and click Done to open the Head Alignment wizard (see
“Aligning the Print Heads” on page 30).

® select No and click Done to align the heads at another time.
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Head Optimization Wizard

L Print-head Optimization
Completed
e;l : Do you want to run the 'Head Alighment' wizard
Alignment now?
®ives
O Mo
Opgjer

Figure 7-72: Final Head Optimization Wizard Screen

Installation  If the printer detects that there is a problem after you install print heads,
Problems relevant warning screens appear.

® If the printer software does not sense the replaced head, the following
warning screen appears.

Head Optimization Wizard

One or more heads
not inserted correctly

Remaove and re-insert the driver cannector(s)

OBJET

? Help x Lancel ‘ Q Previots ‘

Figure 7-73: Incorrect-installation screen

If this happens:
a. Open the print head compartment (see figure 7-63 on page 43).

b. Re-insert the print-head driver card into its socket (see figure 7-67
on page 44).

c. In the wizard screen, select the check box to confirm that you have
re-inserted the card, and click Next.
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¢ If the replacement head was not factory-calibrated, the following
warning screen appears.

Head Optimization Wizard

Inserted head does not contain

S factory data
f \ The installed head does not contain valid data. Try
i replacing it with another head. Ifthis does not
succeed, contact Customer Support.
S :
[~ Aternate prirt head installed.
(@511

? Hep

Figure 7-74: Invalid-data warning screen

If this happens:
a. Remove the head and replace it with another one (starting with step
9 on page 7-42).
b. In the wizard screen, select the check box to confirm that you have
installed another print head, and click Next.

c. Contact your authorized Objet Customer Support center about the
unformatted head.

® If the vacuum test is not successful, the replacement head was not
sealed properly during installation, and the following warning screen

appears.

Head Optimization Wizard

Vacuum leakage detected!

Avacuum leakage was detected. The next steps will guide
wau through the procedure for re-installing the head({s).

©BJET

? Help XK Cancel ‘ =L Previous ‘ iM

Figure 7-75: Vacuum Leakage warning screen

If this happens:
a. Click Next.

b. Follow the instructions on the wizard screens to re-install the head.
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Testing and
Calibrating the
UV Lamps

DOC-13000 Rev. E

The effective radiation of the UV lamps used for curing models can change
over time. To ensure optimum curing of models during printing, a pop-up
message reminds you to test the lamps and calibrate their effective UV
radiation after every 200 hours of printing. You do this by running the UV
Calibration Wizard and using the built-in UV radiation sensor.

The wizard compares the radiation you measure to the recommended
radiation level for each of the lamps, at each printing mode—High Speed,
High Quality and Digital Material. The radiation level is considered
acceptable if it is within seven percent of the recommended level.

When calibrating the lamps, the wizard attempts to adjust the radiation
level, if necessary, and then prompts you to take a new reading. If the level
is acceptable, the wizard continues to the next phase. If further adjustment
is necessary, the current phase is repeated. If the level is too low to be
adjusted, the wizard continues to the next phase; the final wizard screen
indicates that the lamp’s radiation for the printing mode is unacceptable.

To test and calibrate UV lamp radiation:

1. Start the UV Calibration wizard from the Options menu (see figure 7-26
on page 23).

2. Make sure that the build tray is empty, the UV sensor is exposed and
clean, and that the printer cover is closed. Confirm this in the wizard
screen and click Next.

UV Calibration Wizard

Prepare the printer

\ = Confirm before continuing:

N [ The build tray is clear (smpty).
[ The U senzor is exposed (uncovered).
[] The Ut-sensor glass is clean.

[] The printer cover is clozed.

I XK Cancel ‘ ’*Erevious‘

Figure 7-76: Confirmation screen

The UV lamps power up and stabilize; this takes several minutes. Then,
the print block passes over the sensor.

The wizard compares the measured radiation to the recommended
level for the lamp and printing mode tested, and displays the result.

The wizard continues as follows:

® If the level measured in the previous test is acceptable, the wizard
begins testing the left UV lamp.

® If the level measured in the previous test is not acceptable, the
wizard calibrates the right UV lamp by adjusting the current
supplied to it, then tests it again.

® If the level measured in the previous test is too low to be adjusted,
the wizard records the lamp’s radiation as unacceptable, and begins
testing the left UV lamp.
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When all test have finished, the results are displayed. This shows the
current condition of the lamps, after the wizard has calibrated them.

U¥ Calibration Wizard

OBJET

UV Calibration Results

Left LY Lamp Right LV Lamp
High Speed v
(151 41700 % [1-:1] [96 /130) % [4->30]
[ton weak)]
High Guality v v
(151 A100) % [1-:1] [96 /100) % [3-:3]
Digital M aterials v V4

[181 41000 % [1-:1]  [96./100) % [3-3]

Figure 7-77: Results and current condition of the UV lamps

Cover the UV sensor, and confirm this in the next screen.

In the final wizard screen, click Done.

U¥ Calibration Wizard

OBJET

UV Calibration Wizard
Completed.

Figure 7-78: Final UV Calibration Wizard screen
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Calibrating the Load cells are sensors that measure the weight of the printing cartridges

Load Cells and the waste container in the printer. It is important that you periodically
check that the weight measurements are accurate, both for convenience and
to prevent unnecessary waste of printing materials. It is recommended that
you calibrate the load cells once a month, with the Load Cell Calibration
wizard.

To calibrate load cells:
1. Start the Load Cell Calibration wizard.

® From the Options menu of the printer interface (see figure 7-26 on
page 23), select Wizards > Load Cell Calibration.

2. Select one or more load cells that you want to calibrate, and click Next.

Load Cell Calibration Wizard E|

Choose Calibration Mode

[~ Calibrate Suppart-2 cartridge weight

[~ Calibrate Suppart-1 cartridge weight
[~ Calibrate Model-2 cartidge weight
[~ Calibrate Model-1 cartidge weight
[~ Calibrate ‘W aste cartridge weight

OBJET

Cancel |

Figure 7-79: Load cell selection
Note: It is recommended that you routinely calibrate all of the load cells.

3. Remove the cartridge or container, as instructed by the wizard,
confirm this in the wizard screen, and click Next.

Load Cell Calibration Wizard E|

Please remove Model-2 cartridge
from its housing

OBJET

% Help XK Cancel ‘ <& Previau ‘ Mext 3

Figure 7-80: Confirmation of cartridge removal
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Replacing the
Odor Filter

Replacing the
UV Lamps

7-52

4.

6.

In the next wizard screen, observe the numbers and wait until the level
is relatively stable —two units above or below the average level shown.

Load Cell Calibration Wizard E|

Model-2

44D
Current Level 1422

[~ ‘weight iz stable

OBJET

2 Help XK Cancel ‘ ~ Previous ‘ lest 22 ‘

Figure 7-81: Load cell calibration screen

Select the Weight is stable check box, and click Next.

If you need to calibrate more than one load cell, the next calibration
screen appears. Repeat steps 4 and 5 until all of the load cells are

calibrated.

Click Done in the final wizard screen.

Load Cell Calibration Wizard E|

Load Cell Calibration Wizard was
completed succesfully!

OBJET

Figure 7-82: Final wizard screen

The Connex500/350 printer has an activated-carbon filter for removing
odors from printing materials. The filter should be replaced regularly
(about once a year, as necessary) to keep your working environment
pleasant. This is normally done during the yearly preventive-maintenance
service visit.

The UV lamps used for curing models have a long, but limited, working
life. The Objet service engineer tests their effectiveness during regular
maintenance checks, and replaces them, if necessary. You can test and
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adjust their effective power with the UV Calibration Wizard (see “Testing
and Calibrating the UV Lamps” on page 49. If you need to replace a UV
lamp, follow these instructions:

1. Make sure the Connex printer is in offline mode.

Figure 7-83: Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be
red. If not, click it to switch the printer to offline mode.

WARNING: Before continuing, make sure that the safety interlock in the
printer cover is not defeated, and that the lamp is not hot.

2. Start the UV Lamp Replacement wizard.

From the Options menu of the printer interface (see figure 7-26 on
page 23), select Wizards > UV Lamp Replacement.

3. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer cover and click Next.

U¥ Lamp Replacement Wizard g|

UV Lamp Replacement Wizard

Yerify that there isn't any model on the tray

? Help x LCancel ‘ Q =il ‘ ﬂext) ‘

Figure 7-84: “Empty tray” confirmation screen

The axes move to the “home” position.

4. Select the UV lamp(s) to be replaced and click Next.

U¥ Lamp Replacement Wizard g|

Select the UV lamp you wish to
replace:

I~ Right U Lamp
I Left U Lamp

? Help x LCancel ‘ Q =il ‘ ﬂext) ‘

Figure 7-85: UV lamp selection screen
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5. Disconnect the power connection to the UV lamp.

~

Figure 7-86: Disconnecting the UV lamp
Note: Do not disconnect the power connection to the cooling fans.

6. Loosen the screw securing the UV lamp cover (A), and pull the cover
up (B), then out (C).

Figure 7-87: Removing the UV lamp cover

7. Pull the lamp reflector out of the print block.

Figure 7-88: Removing the UV lamp reflector
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8. Inspect the new lamp reflector, and make sure that a black strip is
attached to the inside of it. If not, install one—on the side of the
reflector opposite (not next to) the print block.

Note: Extra black strips are included in the printer Start-up Kit. If
necessary, you can remove the black strip from the old reflector and install
it in the new reflector (as long as the black paint has not faded).

9. Discard the old reflector and lamp.

Dispose of the used UV lamp in accordance with environmental and safety
requirements.

10. Insert the new UV lamp/reflector unit into the housing next to the print

block.
UV lamp UV lamp
assembly assembly

Black strip4‘ /—Black strip

Figure 7-89: Print block and UV lamp assembly, showing correct placement of
black strip

11. Replace the lamp cover by inserting it into the slot on the bottom of the
housing, and tighten the securing screw on top.

/'

Figure 7-90: Replacing the lamp cover
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12. Reconnect the power connection to the UV lamp.

Figure 7-91: Connecting power to the UV lamp

13. In the wizard screen, confirm that you have replaced the lamp(s) and
that the black strip is attached, then click Next.

U¥ Lamp Replacement Wizard [Z|

UV Lamp Replacement Wizard

v L lamp replaced

v iShadow bracket located correctly [zee help}

? Help x LCanicel ‘ Q Presyio ] ﬂext) ‘

Figure 7-92: UV-installation confirmation screen

The wizard operates the lamps and checks if their power is within the
acceptable range for each printing mode. (The mode currently being
checked appears in the lower-left corner of the printer interface.)

U¥ Lamp Replacement Wizard [Z|

UV Lamp Replacement Wizard
LY lamp(s) warming up. This takes about 4 minutes.

00:09

xgancell ]

Figure 7-93: Status screen during UV lamp check

7-56 DOC-13000 Rev. E



Connex500/350 User Guide

Built-in Tests
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14. After replacing a UV lamp, it is recommended that you calibrate its
power for the various printing modes. The final screen allows you to
continue to the UV Calibration wizard (see “Testing and Calibrating
the UV Lamps” on page 7-49).

UV Replacement Wizard

UV Replacement Wizard was
é completed succesfully!
=

Do you want to run the 'Y Calibration ‘Wizard'
now?

™ Mo

+ ‘Yes

( OsJET
_afCE = | \/Donel

Figure 7-94: Final wizard screen

The software that runs your Connex printer contains a suite of tests for
regularly checking the hardware and software, and for troubleshooting.
You can configure basic communications and environment tests to run
automatically, when the Connex software opens. In addition, you can run a
more comprehensive set of tests before processing a print job, as a system
check, to ensure optimum printing results.

Because running the tests effects the operation of the printer, you can only
open the Built-in Tests interface when the Connex system is not printing.

The test suite features:

® The organization of printing-related tasks in categories:
Communications

Data cards

Temperatures

Voltages

Encoder repeatability

Qooaoaaqaa

Print-head heating
O Print-head filling

® A clear display of test results and the source of any failures, enabling
you to determine if printing is possible or worthwhile.

® The ability to monitor test results for specific components.

¢ Troubleshooting tips.

Running these tests can help identify problems in the printer hardware and
software. A large number of hardware defects (or near-defects) warns you
of possible printing problems, either for current or future jobs.

Objet recommends running the built-in tests in the following cases:

® as aroutine test, once every two weeks

® as a system check, before major (long) jobs

¢ as needed, for troubleshooting
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Accessing
Built-in Tests

Test Interface

Test List

To open the Built-in Tests screen, do one of the following:
® From the Options menu, select Built-In Tests.
® Press Ctrl+Alt+B.

ations Help

Go ko Tray Upper Position FS
@ Go ko Purge Position F&

Wipe F?
Purge Sequence F4
Pattern Test F3

‘Wizards
Built In Tests... Chrl4+-AlE+E

Maintenance Counters...

Collect Service Data

Figure 7-95: Selecting Built-In Tests from the Options Menu

The Built In Tests screen lists pre-configured tests, grouped by component
categories. In this screen, you select and run tests, and the results are
displayed.

Built In Tests [Z|
Test Hame Group Status | Eror Deseription
O Sub-Sypstems Communication Communicat. .. ? -
O FIFD Mon-ntermupt Test Data Card o a Fieset
O FIFD Intermpt Test Data Card ? =
O Encoder Test Encoder ?

O System Info E revironment ?
[ Elock Filling Filing ?
O Interlack Test General ?
[ Cabin Temperature General ?
[ Heads EEFROM Head Cards ¥
[ Heads Yaoltages Head Cards ? “Summary
[ Head/Block Heaters Heaters ? 2
[ Axes Limits Test Matars ? 2
O+ acuum Test Wacuum ?
] |
Tests Selection =
Group Selection Set "‘E Help
All J MNone | Uik riowar J J Maone - lJ | Mone - j ﬁ =
ose

Figure 7-96:Built In Tests screen
Test Name
This column lists all of the tests, together with selection check boxes.

Click the check boxes to select the tests you want to run. To remove a
selection, click the check box again. To quickly select all of the tests in a
component category, use the Group pull-down menu at the bottom of the
screen.

Group
This column shows the component categories for each test.

This tells you which tests are run when selecting a category from the Group
pull-down menu at the bottom of the screen.
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Status

This column shows the status of each test after you run it:

o Test successfully completed.

X Test failed.

?  Unknown results. (The test has not been run yet.)

Test Selection Area  In the Test Selection area, at the bottom of the screen, you can quickly select
or de-select tests by their characteristics:

All Click to select all of the tests in the list.

None Click to de-select all of the tests in the list.

Unknown Click to select all test that have not been run yet (Status = ?).
Group Use this menu to select tests by component category.
Selection Use this menu to select a pre-configured set of tests to run at
Set specified times (computer startup, before printing, etc.).

Running Tests To run the selected tests:
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» Click Run

After you run a test, the Save and View command buttons are added to the
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Test Results

Command Buttons

@ Bun
a Reset

F:J Save

S Wiew

Surnmary

X

‘ug Help
32 Cloze

Summary

7-60

To save and view a report of all of the tests:
» Use the Save and View command buttons (see below).

You click the command buttons, on the right side of the screen, to perform
the following operations:

Run

Click to run the selected tests.

Reset

Click to clear previously run tests. This returns the status of each test to
Unknown (?).

Save

Click to save a report that summarizes the tests run. The report is saved as
an HTML file. You can save any number of reports for the tests you run; the
name of the file saved is BITReport [date][time].htm. By default, these files

are saved in the Connex installation folder, but you can save it in any other
folder.

View

Click to display the latest test report that you saved. (You can view other
test reports by opening the relevant files in your Web browser. To do so,
open Windows Explorer, and double click the BITReport file.)

Close
Click to close the Built-in Tests screen.

On the right side of the screen, a symbol represents the combined results of
all the tests run, using the symbols from the Status column.

o  All tests successfully completed.
X  Atleast one test failed.

? Notall tests performed.
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Test Descriptions  The following table lists the name of each test in the Built-in Tests suite,

and

together with its description and a possible reason for its failure. If you

Troubleshooting need assistance, contact your Objet service provider.

Test Name Description Possible Reason for Failure
Sub-System Tests communications between Disconnected communications cable.
Communication Eden components. Faulty cable.

FIFO Non-Interrupt/
FIFO Interrupt

Tests the data queue in the DATA
PCI card.

Faulty DATA_PCI card.

Encoder

Tests the encoder's reliability by
comparing readings from multiple
runs along the X-axis.

Faulty encoder.

System Info

Compares the following parameter
values with the minimum
requirements.

* Physical memory
* Available memory
* Free space on disk

e Monitor resolution

Failure of RAM memory allocation in
the Eden computer.

Block Filling Analyzes the thermistor readings | Faulty thermistor.
when the block is full and when it is
empty.

Interlock Tests the interlock in the printer Failure of interlock mechanism.
cover. Faulty latch.

Disconnected cables.

Cabin Temperature | Tests the temperature level in the | Faulty temperature sensor (OHDB).
build-tray area.

Head EEPROM Tests the read/write capabilities of | Faulty print-head driver card.
the print-head driver cards.

Head Voltage Checks the control of voltages Faulty print-head driver card.
supplied to the print heads.

Tray Heater Not used for this printer —

Head/Block Heaters | Tests the heaters in the print heads | Faulty heaters or thermistors.
and in the print-block body.

Axes Limit Tests the hardware and software Faulty hardware sensors.
limits of all axes. Wrong Max Position parameter.

Vacuum Tests the vacuum level in the print | Faulty vacuum sensor.

block.

Vacuum leakage.
Wrong parameters.
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Replacing the  The waste container contains partially cured polymeric material produced

Waste during normal operation and maintenance of the Connex printer. For safety

Container and environmental reasons, this material is kept in a special leak-proof,
disposable container.

The container has a capacity of 10 kilograms of waste material —usually
enough for several months of printer use. The printer software displays a
warning message when there is 9 kilograms of material in the container,
and stops the printer when the net weight reaches 9.5 kilograms. Above 9
kilograms, the software does not allow you to start a print job (or a printing
activity) until you replace the waste container. You can monitor the weight
of the waste container in the Maintenance screen of the printer interface. You
can also visually inspect the level of waste in the container. (To access it, see
page 7-63.)

To monitor the waste weight (and other indicators) in the Connex printer:

> In the main printer interface screen, click the display toggle to view the
Connex printer indicators.

10 Jan 2008  16:47

Heads (°C)
s BB Ed v

Waste (ar) 9000 Heads Liquid

Ambient (°C) Heads Vacuum
UV Lamps n Pre Heater

Display
toggle button

CONNEXS00O

Figure 7-97: Connex printer interface, showing waste weight (red background
indicates operator alert)

The waste container consists of a plastic container inside a cardboard box.
You typically dispose of the entire waste container —including the box.
Therefore, you must assemble a new box and insert a new plastic container
before you can install it in the printer.

Replacement boxes, plastic containers, and sealing caps are supplied in the
Connex printer start-up kit and in the preventive-maintenance Kkit.
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To prepare a new waste container:

1. Assemble the cardboard box, making sure to punch out the perforated
sections.

2. Place a new plastic container into the box.

Note: Do not close the box until you connect the waste drain tube from the
printer (see below).

To replace the waste container:
1. Open the front doors of the printer.

Figure 7-98: Accessing the waste container

Carefully slide out the waste container to remove it from the printer.
Place the new waste container next to the full container.

Unscrew the cap securing the waste drain tube and connect it to the
new container.

5. Close the full container with a sealing cap.
Close the new waste-container box, using tape to hold it closed.

Position the waste container under the Connex printer, on the load
cells.

® The container should be on the extreme right side of the
compartment.

® Make sure that the waste drain tube is not crimped and that it is not
pinched by the container.

8. Close the waste compartment door.

Dispose of the full waste container in accordance with environmental and
safety requirements.
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Cleaning the The painted exterior plastic panels of Connex 3-D printers have a durable

Exterior Panels finish, offering excellent chemical resistance to common cleaning agents.
However, follow the recommendations below when cleaning these areas of
the printer.

Acceptable Cleaning Agents

® mild soap solution

® common household cleaners and window cleaners

® common commercial and industrial detergents, 5% solution in water
® alcohol (ethanol, isopropanol), 10% to 40% solution in water

Wipe the exterior of the printer, using a soft cloth moistened with the
cleaning solution.

Unacceptable Materials
® industrial solvents

® cleaning agents containing hydrocarbons, ketones, esters and lacquer
thinners

® spray disinfectants

® abrasives and agents which could wear away the panel finish
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Handling Printed Models

Removing Models After Printing...........c.cccocoevvvnnniniincncnenne,
Removing the Support Material...........cccccoeviiiiiiiiniiiine

Storing Models
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Handling Printed Models

Removing Models After Printing

N

After printing models, you should allow them to cool as much as possible
before handling them. If additional models do not have to be produced on
the Connex printer, it is best to let the printed models cool in the printer,
with the cover closed, as long as possible.

If the Connex printer must be used to produce additional models as
soon as possible:
1. Let the printed models cool on the build tray for at least 10 minutes.

2. Very carefully, remove the models from the tray with a scraper or
spatula (supplied in the tool kit), taking care not to pry or bend the
model.

WARNING: Wear protective gloves when handling printed models
before they are washed.

3. Place the models on a flat surface, and cover them with a cardboard
box or paper hood.

This allows the models to cool slowly and evenly.

4. Let the models cool for several hours.

Removing the Support Material

8-2

After printed models have cooled, the support material must be removed.
This can be done by different methods, depending on the size of the model,
how delicate it is, the amount and location of the support material, and
other factors. Use the following methods as a guide, and adapt them (or a
combination of them) for finishing the models you are handling.

Removing Excess Support Material by Hand

While wearing protective gloves, break away excess support material on
the outside of the model. For delicate models, use a toothpick, pin or small
brush after dipping the model in water.

Removing Support Material with Water Pressure

For most models, the most efficient way to remove support material is by
using a high-pressure water jet. One suitable system is the Balco Water]Jet
cleaning unit, shown in figure 8-1 on page 8-3. This device is marketed by
Objet.
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Figure 8-1: Balco WaterJet Cleaning Unit

To clean a model using this device, you place it in the chamber, and you
manipulate it and the jet using the built-in, waterproof sleeves. A pump
turns ordinary tap water into a high-pressure jet, and a wiper keeps the
window clear.

Use caution when cleaning delicate models with high-pressure water
systems.

Removing Support Material with Caustic Soda

Soak models in a 2-percent solution of caustic soda (sodium hydroxide) to
remove support material from difficult-to-reach areas and to give the
model a smooth, clean finish. The amount of time you soak the model in the
solution depends on how delicate it is and how much support material
needs to be removed, but it is typically between half-an-hour and several
hours. In any case, you should remove as much support material as
possible before the caustic soda treatment, and rinse the model thoroughly
(with a water jet) afterwards.

WARNING: Caustic soda may cause chemical burns, scarring and
blindness. Mixing it with water generates heat that could ignite other
materials.Take adequate safety precautions; always use nitrile gloves
when handling caustic soda and models soaked in it.

Storing Models

DOC-13000 Rev. E

Models are cured as they are printed, making them safe and stable for a

long time. However, proper storage conditions are necessary to prevent

deforming.

® Keep printed models at room temperature and in a low-humidity
environment.

® Do not expose models to direct sunlight and other heat sources.
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